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1. CanKing 5

CAN Hardware와 Software 설치

(1) CAN Hardware 설치

CAN Hardware와 같이 제공된 CD나 당사 홈페이지(www.eskorea.net) 자료실에서 다운받은 드라이

버를 설치하여 주십시오. CAN Hardware를 PC에 설치하면 자동으로 추가 하드웨어 마법사가 CAN

Hardware를 인식하여 드라이버를 찾습니다.

(2) 제공된 CD나 자료실에서 CANKing 소프트웨어를 추가로 설치하여 주십시오.

(3) CAN Hardware와 사용자 Target을 연결하기 위해 별도의 케이블을 제작하십시오.

CAN Hardware의 DSUB-9(male)에서 2번(CAN-Low)과 7번(CAN-High)을 케이블(사용자가 제작)로

Target의 CAN port의 CAN-Low와 CAN-High에 연결하셔야 합니다.

이 때 주의 사항은 케이블의 2번과 7번 사이에 종단 저항 120Ω을 양 끝에 달아주셔야 합니다.

(4) 사용하시는 CAN Hardware의 CAN port가 2개라면 CAN 통신 테스트가 가능합니다.

이것에 대하여는 나중에 설명하겠습니다.
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기초적인 개념

Project:

창들의 환경과 연결들, 위치들, 등등을 수집합니다. 사용자는 일반적으로 프로젝트 파일로 사용자의

작업을 저장합니다. 사용자가 다음에 그것을 열 때 끝냈던 곳에서 계속할 수 있습니다.

Template:

사용자의 독창적 프로젝트를 위한 'seed'. Kvaser CanKing 은 여러 개의 서로 다른 템플릿들을

제공합니다.

메인 메뉴

File

파일 열기, 닫기, 저장하기, 등에 대한 표준 명령들을 포함합니다

View

여기서 엔트리들을 선택하면 관련 창을 번갈아 볼 수 있게 토글이 됩니다. 현재 보인 창문은 체크

부호로 체크됩니다.

Messages

이 메뉴의 내용들은 사용된 template 또는 project 파일에 의존합니다. 일반적으로 이것은 여러 작

은 창들을 위한 엔트리들을 포함하며, 각각은 다소 특정적인 CAN 메시지를 전송.

Options

global (program-wide) 옵션의 엔트리와 또한 이미 설치되어 있는 적용 가능한 플러그인 모듈을 위

한 엔트리들을 포함

Window

여기서 엔트리를 선택하여 해당 윈도우를 위로 가져가서 이것을 현재 윈도우로 만듦.

Help

on-line help를 활성화하고, 인터넷 기반인 help에 쉬운 접근을 제공합니다.
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File View Messages → Universal

Options Window Help

→ CAN Kingdom
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프로그램 옵션들

옵 션 효 과

Autosave Layout
project가 닫힐 때 창 위치들에 어떤 변화들이라도 자동으로 저장합

니다.

Autosave

Configuration

project가 닫힐 때 구성에 어떠한 변화라도 자동으로 저장합니다.

(이 옵션은 이 버전에서 효과를 가지고 있지 않습니다.)

Keep Help on

Top

help 창이 활성화 되었을 때, Kvaser CanKing에 속한 다른 창들의

위에 이것을 놓아둡니다.

Default Numeric

Base

현재 구성(configuration)에서 사용하기 위하여 Decimal 또는

Hexadecimal 을 선택하십시오. 이 옵션은 configuration 또는

template으로 저장되고 복구됩니다.
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새로운 프로젝트 만들기

템플릿으로부터 새로운 프로젝트를 만들려면 Template을 선택하십시오.
사용자가 이미 만들어진 프로젝트를 열려면 "Open an Existing Project"를 선택하십시오.

Template 선택

먼저 일치하는 템플릿을 선택하기 위해 아이콘들 중의 1개를 더블 클릭하시오.

힌트 : 만약 사용자가 버스에 무슨 일이 있는 것을 보기를 원하면, "CAN Kingdom Basic"을 선택하십시

오.

Keyboard 단축 키들

아래 단축 키들은 Kvaser CANKing에서 사용될 수 있습니다.

Key 효 과

Ctrl-F6
보조 창들을 순서적으로 선택할 수 있습니다.

Shift-Ctrl-F6는 역방향에 순회합니다.

Shift + menu

selection

어떤 창의 다음 instance를 만듭니다, 예를 들면 Shift 키를 누른

상태에서Universal Page를 열면 또 하나의 Universal Page가 열립

니다..

F1 도움말.

F4
사용자는 16진법(hex)과 10진법(decimal) 표시를 F4 키로 전환할

수 있습니다.

CAN 식별자(ID:Identifier)들 입력

사용자는 CAN Identifier를 입력할 수 있는 곳에서，아래의 표기법을 사용할 수 있습니다:

Remote Frames: "r"을 ID 번호에 추가합니다. 예를 들면 "0x100r"

Extended (29-bit) Identifiers: "x"을 ID 번호에 추가합니다. 예를 들면 "0x100x"

Hexadecimal input: ID 번호 앞에 "0x" 또는 "$"를 붙입니다.
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예를 들면:

123 = Standard ID 123 (decimal.)

123x = Extended ID 123 (decimal.)

123rx = Remote frame, ID 123 (extended, decimal.)

0x123x = Extended frame, id 123 HEX.

Note

- 사용자는 16진법(hex)과 10진법(decimal) 표시를 F4 키로 전환할 수 있습니다.

- Options → Global... 메뉴를 사용하여 decimal/hexadecimal 중 우선권을 선택할 수 있습니다.

하드웨어

Kvaser CanKing는 Kvaser에 의하여 만들어진 모든 CAN 인터페이스들을 지원합니다.

Virtual Channels

CAN 드라이버 루틴은 어느 정도 실제 CAN 버스처럼 행동하지만 소프트웨어에서 구현되는 "virtual

channel"들을 지원합니다. 사용자가 드라이버 패키지를 설치할 때 가상 채널(virtual channel)들은

설치됩니다.
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2. CANKing 모듈들

Kvaser CanKing는 각각 다른 창문을 몇 가지를 포함하는 몇 개의 플러그 인 모듈들로 만들어졌습니다.

모든 프로젝트와/또는 템플릿에서 모든 창이 나타나지는 않습니다.

만약 사용자가 여기에 어떤 창에 대하여 읽고 메인 메뉴에서 그것을 발견할 수 없으면, 그것은 아마도

사용하고 있는 프로젝트에 포함되지 않기 때문입니다.

예를 들면 Traffic Generator는 "Traffic Generator" 템플릿에 포함됩니다, 그러나 그것은 "CAN

Kingdom" 템플릿에 포함되지 않습니다.

Formatter 창

Formatter 창은 CAN 메시지들을 텍스트 문자열들로 변환합니다.

이용할 수 있는 많은 다른 formatter들이 있습니다. 이것들은 창에 표시됩니다.

사용 중인 formatter들은 위의 리스트에서 아래쪽에 (관련 박스에 체크되어)표시됩니다.

한 번에 1개 이상의 formatter를 선택할 수 있습니다.

사용자는 특정한 formatter를 선택하고 Up 또는 Down 버튼을 누르는 것으로 formatter들의 순서를 바

꿀 수 있습니다.

몇 가지 formatter들을 추가 구성할 수 있습니다, formatter를 선택하고 Use 버튼을 누르거나 더블 클릭

하면 됩니다.



[9]

Formatter 기 능

Standard Text

Format

CAN Identifier，메시지 flag들，길이와 내용들 그리고 시간(time stamp),

메시지의 방향을 가리키는 문자로 된 라인들을 만듭니다.

Interpret

King's Pages
발견되는 모든 CanKingdom King의 Page들의[간결한]번역을 만든다

Simple Alarm

Pass Filter
소프트웨어 메시지 필터 역할을 합니다. 어떤 범위내의 CAN 식별자들을

가진 메시지들만은 통과 하게 됩니다.

Stop Filter
소프트웨어 메시지 필터 역할을 합니다.

어떤 범위내의 CAN 식별자들을 가진 메시지들은 막습니다.

DLL Formatter
이 formatter는 사용자가 작성한 DLL에 들어오는 메시지들을 구성

(format) 합니다. "formdll" 견본을 보십시오.

Simple

CANopen

interpreter

특정 CANopen 메시지들을 번역합니다, 그러나 이 formatter 는 여기서

그다지 중요하게 해석되지 않을 것입니다.

이 formatter는 Kvaser CanKing의 모든 release들에 없을 것입니다.

Simple

DeviceNet

interpreter

특정 DeviceNet 메시지들을 번역합니다, 그러나 이 formatter 는 여기서

그다지 중요하게 해석되지 않을 것입니다.

이 formatter는 Kvaser CanKing의 모든 release들에 없을 것입니다.

Simple J1939

identifier

interpreter

J1939 확인들을 해석합니다.

이 formatter 는 여기서 그다지 중요하게 해석되지 않을 것입니다.

이 formatter는 Kvaser CanKing의 모든 release들에 없을 것입니다.

Better Filter
개선된 소프트웨어는 필터입니다, 그러나 그것은 이 release에서 실현되

지 않았습니다.

Note

사용자는 작은 체크 박스를 체크하지 않는 한 사용자는 formatter를 구성할 수 없습니다.
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Output 창

Output 창은 Formatter 창에 의해 일반적으로 만들어지는 본문 문자열들을 표시합니다.

이용할 수 있는 팝업 메뉴가 있고 아래 옵션들을 제공합니다:

옵 션 효 과

Fixed Positions

CAN 메시지들은 CAN Identifier에 따라 리스트에 고정된 위치들로 표시

됩니다.

새로운 메시지들은 같은 식별자로 오래된 메시지들을 덮어 씁니다.

이것은 버스 통신이 혼잡할 때 좋습니다.

Options...
output 창을 위해 몇몇 옵션을 줄 수 있는 창을 팝업시킵니다.

현재는 버퍼 크기와 폰트를 설정할 수 있습니다.

Copy contents

to Clipboard
Clipboard에 창의 내용을 복사합니다.

Clear 리스트를 지웁니다.

History 창

History 창은 사용자가 Universal Page, King's Page0, 그리고 그 외처럼 메시지 대화 창을 사용하여

보냈던 모든 메시지들의 리스트를 포함합니다.

사용자는 파일에 History 창의 내용을 저장할 수 있고 나중에 내용을 복구시킬 수 있습니다.

이것은 사용자에게 단순한 스크립팅 기능을 제공합니다.

History 창의 내용은 Timed Transmission 창에서 전체 또는 일부분을 전송할 수 있습니다.

버 튼 효 과

Send All
history 리스트에서 현재 모든 메시지들을 보내기 위한 Timed Transmission

창을 활성화 합니다.

Send Selected
history 리스트에서 현재 선택된 메시지들만을 보내기 위한 Timed

Transmission 창을 활성화 합니다.

Load 파일에 이전에 보관되는 히스토리 리스트를 읽습니다.

Save 파일에 히스토리 리스트의 내용들을 씁니다.

Clear 히스토리 리스트의 내용을 지웁니다.

Note

사용자는 마우스로 드래그 하는 것에 의해 위로 또는 아래로 메시지들을 이동시킬 수 있습니다.
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Timed Transmission

Timed Transmission 창은 소스로부터 CAN 메시지들을 재발송할 수 있습니다, 그것은 보통 History 창

입니다.

Transmission Mode 효 과

One-Shot 메시지들을 한 번 전송

Cyclic Stop 버튼이 눌러질 때까지 되풀이하여 메세지들을 전송

Message Timing 효 과

Fixed Interval 각각의 메시지 사이를 지정 받았던 millisecond(ms)의 수 동안 대기

버튼 효 과

Send transmission 시작

Pause
일시적으로 전송을 멈춤.

Start를 누르면 그것이 잠시 멈추었던 지점으로부터 다시 전송을 재개합니다.

Stop
transmission을 멈춤.

Start를 누르면 처음부터 전송을 재개합니다.

Note

CAN 메시지들의 다른 세트를 보내기 위해，메시지들 흐름（보통 History List）을 위해 소스로 가서

그 곳에서 변경합니다.

메시지들의 소스는 사용된 템플릿 또는 프로젝트 파일에서 정의되며, 이 버전의 Kvaser CanKing에서

는 사용자가 쉽게 변경할 수 없습니다.

Timed Transmission 창과 소스 간의 연결은 부분적으로 동적으로 이루어집니다.

Timed Transmission이 사용할 메시지 소스를 가지고 있지 않을 때, 다음 "No Source"가 표시됩니다.

메시지들 사이의 시간은 비록 Windows가 매우 우수하다 할지라도, 근사 값입니다.
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Traffic Generator

Traffic Generator는 테스트 목적을 위해 CAN 메시지들의 흐름을 만듭니다.

메시지들은 지정된 간격으로 버스트에서 생성됩니다.

[The Rate tab]

Interval:

메시지 버스트들 간의 간격 설정합니다.

간격은 일정하거나 지정한 간격으로 임의로 변할 수 있습니다.

Burst Size:

메시지 버스트들의 크기를 설정합니다.

크기는 일정할 수 있거나 특정한 간격에 임의로 변화할 수 있습니다.

[The Count tab]

Number of Messages:

보내는 메시지들의 총 수를 설정합니다.

"Continuous transmission" 체크하면 Stop 버튼을 누를 때까지 메시지들을 전송합니다.

[The Id tab]

CAN Identifier:

CAN 메시지들에서 식별자들의 범위를 지정하십시오.

사용자는 식별자 범위의 하위와 상위 경계를 정할 수 있습니다.

Random:

선택한 간격 내에서 식별자들을 무작위로 다양하게 하려면 이 곳을 체크합니다.

scan from lowest to highest:

메시지의 하위 4개 데이터 바이트는 메시지 번호 - 0으로 시작, 각 메시지에 대해 하나씩 증가하는

- 를 포함하게 됩니다.

Use Extended identifiers:

11 비트의 식별자 대신에 29 비트의 CAN 식별자를 보내기 위해 여기에서 체크합니다.

Number of Messages:

보내는 메시지들의 총 수를 설정합니다.

"Continuous transmission"를 체크하면 Stop 버튼이 누를 때까지 메시지들을 전송합니다.
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[The Data tab]

Length:

CAN 메시지들의 길이를 지정하십시오.

Random Length:

0부터 지정된 길이 가운데 길이를 무작위로 다양화 하려면 이 곳을 체크 하십시오.

Message Number in Data Part:

메시지의 하위 4개 데이터 바이트는 메시지 번호 - 0으로 시작, 각 메시지에 대해 하나씩 증가하는

- 를 포함하게 됩니다.

Random Data:

메시지들의 데이터 부분은 무작위로 선택됩니다.

[The LFSR tab]

이 버전에서 실현되지 않습니다.

Note

사용자가 높은 BUS load를 발생시키기 전 모든 활성 formatters를 끄는 것(off)이 매우 권장됩니다.
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CAN Controller 창

CAN bus 매개 변수(parameter)들, 전송속도(bit rate), 그리고 CAN bus를 위한 통계를 관리하기 위해

CAN Controller 창을 사용 하십시오.

이 창은 3가지 탭으로 구성되어 있습니다:

Bus Statistics

Bus Parameters

H/W Filters

[The Bus Statistics 탭]

그림2-1

버튼 효 과

Clear
bus 통계 카운터들을 지웁니다.

에러 카운터들은 영향받지 않은 채로 있습니다.

Go On Bus CAN Controller를 CAN bus에 접속합니다.

Go Off Bus CAN Controller를 CAN bus에서 분리합니다.

Bus Statistics

이 영역은 마지막 초 동안에 평균적인 bus load 평균값을 보여 줍니다.

마지막 초 동안에 수신과 송신된 메시지들의 수

마지막 초 동안에 수신된 에러 프레임들의 근사 수

on-chip CAN error 카운터의 현재 값
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이러한 카운터들은 오류 발생시 CAN 스펙에 따라 결정되는 양에 의해 증가하며 메시지가 정확히 수신

되는 양에 따라 다시 내려갑니다. 모든 세부 내용을 위해 CAN 명세(spec)를 보십시오.

Clear 버튼이 눌러진 후부터 메시지 카운터는 쌓이게 됩니다.

오버런이 일어날 때 Overrun 램프는 불이 켜집니다.

에러 카운터들은 CAN에 의해 하드웨어를 보고한 것처럼 항상 현재 값들입니다.

[Bus Parameters 탭]

이 영역은 정보의 부분을 아래에 보여 줍니다.

그림2-2

Channel은 사용하고 있는 CAN board의 이름, board 번호(1부터 시작) 그리고 board에서 현재 선택된

channel(이것도 1부터 시작)을 표시합니다. 이러한 번호매김이 어떤 물리적 커넥터를 일컫는 것인지 알

기 위하여 하드웨어 사용자 도움말 또는 하드웨어에 표기된 것을 참고합니다

예를 들면, Kvaser Memorator Professional, 1/2는 컴퓨터에 연결된 1번째 Kvaser Memorator

Professional에 2번째 채널에 대하여 언급할 것입니다.

Settings는 현재 bus 속도(초당 비트수)와 채널 플래그들은 아래 중 적어도 1개를 표시합니다.

대문자 S는 채널이 Silent Mode 안에 있는 것을 의미합니다－그것은 버스에서 아무 것도 보내지 않

을 것입니다. 소문자 s는 채널이 표준 모드에 있음을 의미합니다.

대문자 E는 채널이 Kvaser CanKing에 의해 전용에 있음을 의미합니다.

소문자 e는 채널이 동시에 다른 응용에 의하여 사용될 수 있음을 의미합니다.



[16]

대문자 I는 init 모드 안에 있는 것을 의미합니다 - 그것은 bus에서 물리적인 비트 전송 율(bit rate)을

바꿀 수 있을 것입니다. 소문자 i는 채널이 init 모드에 없는 것을 의미합니다, 그래서 그것은 bus에

서 물리적인 비트 전송 율을 바꿀 수 없습니다 － 그것은 보급하고 있는 비트 전송 율을 사용할 것입

니다.

Bit Timing은 Bit Time Quanta의 수를 표시합니다 (Q),

샘플링 점의 앞에 양자들 수 (S1),

샘플링 점 후에 양자들 수 (S2),

전체 비트의 퍼센트에서 샘플링 점의 위치 (SP),

synchronization jump width (SJW)의 분량 길이

Note : S1 값이 시작 비트를 포함하는 것을 유념하십시오.

Bus Status lamps - CAN controller는 다음 상태들 중의 양쪽 하나에서 있을 수 있습니다: On Bus,

Error Passive, 또는 Off Bus. 램프(lamp)들은 CAN controller의 현재 상태를 반영합니다.

Notes

bus load 모양은 오직 근사 값입니다. 만약 하드웨어가 버스 로드 계산을 지원한다면, 수치들은 거의

1-2 퍼센트 정확합니다.

오버런들은 하드웨어에서, 드라이버에서, 또는 Kvaser CanKing에서 일어날 수도 있습니다.

Overrun 램프는 양 타입의 표시기 역할을 합니다.

Bosch로부터 CAN 규정은 비트 타이밍의 내부 작업들에 관한 상세한 해설을 포함합니다.

몇몇 CAN controller들은 사용자에게 언제 그들이 Error Passive인지를 말하지 않을 것입니다.

그들은 대신에 Error Warning 표시를 제공합니다.

건전한 CAN 시스템은 어떠한 error 프레임들도 가져서는 안됩니다. 그것은 소량의 값들(최대 20)은

일반적으로 문제가 없지만 큰 값들은 심각한 문제를 알리는 것입니다.
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Setting 효 과

CAN

Channel

CAN 보드와 채널을 선택합니다.

채널들은 인터페이스 형태, 보드 상의 보드 번호/ 채널 번호가 표시됩니다.

예를 들면 1번째 PCIcan에 2번째 채널은 Kvaser PCIcan(1/2)로서 표시될 것입니다

Exclusive 이 상자를 체크하면 Kvaser CanKing 이 CAN 채널에 독점적 액세스 권한을 가집니다.

No init

access

이 상자를 체크하면 채널로부터 init 액세스를 제거하는데, 이는 물리적 채널에 있는 bit
rate를 변경하지 않으려 한다는 것 (또는 허용 불가)을 의미합니다.

Bus

Speed

CAN 버스에 비트/초에서 속도를 선택합니다.

속도 중의 하나를 선택하거나, 사용자 자신의 속도를 입력 하십시오.

Sampling

Point

전체 비트의 퍼센트 안에서, 샘플링 점의 위치를 선택합니다.

표준 값은 60에서 90 % 범위 입니다.

SJW
동기(Synchronization) 점프 폭의 크기를 선택합니다.

허용치들은 1에서 4까지 입니다.

Choose...

이 버튼을 누르면 허용된 비트율을 선택할 수 있는 화면을 볼 수 있습니다.

(CAN 칩들은 일반적으로 임의의 비트율 사용을 허용하지 않지만 매우 많은 서로 다른

비트율을 이용할 수는 있습니다. 이 윈도우를 사용하면 사용자가 사용할 수 있는 것들

을 볼 수 있습니다)

Driver

Mode

CAN 드라이버 모드를 선택합니다: Normal 또는 Silent.

Silent 모드는 어떤 것도 버스에 보내지지 않음을 의미합니다.

인터페이스는 비-강요 linstening mode이며 onging 트래픽에 영향을 줄 수 없습니다

Set in all 버튼을 사용하면 현재 사용되는 모든 CAN 컨트롤러들에서 동일한 버스 매개 변수

(parameter)들이 설정됩니다 (버스 속도, 샘플링 지점과 SJW)

Apply 버튼을 누르면 새로운 값들이 효력이 나타납니다.

사용자가 버스 파라미터들을 바꿀 때 CAN controller가 bus-off이어야 되는 것을 유념하십시오.

Note

비트 동기의 내부 일에 대하여 더 많은 정보를 위해 http://www.kvaser.com/can을 보십시오.
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[The Hardware Filters 탭]

표준CAN(2.0A, 11-bit identifiers)과 확장CAN(2.0B, 29-bit identifiers)을 위한 다른 필터들이 있습니다

모든 하드웨어가 다른 필터들을 지원하는 것은 아니라는 것을 유의하세요.

그림2-3

Standard (11-bit Envelopes) messages

Accept All 모든 표준 메시지들을 받아들이기 위하여 이 버튼을 체크 하십시오.

Reject All 모든 표준 메시지들을 거절하기 위하여 이 버튼을 체크 하십시오.

Use Mask and Code 요구된 메시지들을 필터하기 위해 Mask와 Code를 사용하는 것입니다.

Mask

이것은 값입니다. 바이너리 표시의 '1'은 ' 코드의 관련 비트가 중요하다'

는 것을 뜻하고 '0'은 '코드의 관련 비트가 중요하지 않다'는 것을 뜻합

니다.

Code

이것은 바이너리 표현으로 '1'은 메시지의 식별자에 있는 관련 비트가 1

인 경우 그 메시지를 받아들이고, '0' 은 메시지 식별자에 있는 관련 비

트가 0인 경우 그 메시지를 받아 들이는 것을 뜻하는 값입니다.

Set 버튼 Code와 Mask가 효력을 발생하기 위해 이것을 사용하세요．

Extended (29-bit Envelopes) messages

표준 식별자(Standard CAN)와 유사합니다.

Example

"Use Mask and Code"를 체크한 상태에서, Mask에 0xFF, Code에 0x0F를 설정합니다.

그러면 마지막 8비트가 0x0F를 가지고 있는 11-bit ID의 모든 메시지를 수신합니다.

예를 들면, 0x0F, 0x10F, 0x20F.
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3. 용어집

Error

Passive

CAN controller는 Receive Error Counter 또는 Transmit Error Counter가

128을 초과할 때 Error Passive에 있습니다.

Error

Warning

CAN controller는 Receive Error Counter 또는 Transmit Error Counter가

96을 초과할 때 Error Warning에 있습니다.

Off Bus

어찌 되었든지 CAN controller가 CAN bus 통신을 하지 않는(어떤 것도

송신하거나 수신하지 않습니다) Off Bus인 것을 말합니다. Transmit

Error Counter가 255를 초과할 때 CAN controller는 자동으로 Off Bus가

됩니다.

On Bus CAN controller가 CAN 버스 통신에 참가하는 것을 On Bus라고 합니다.

Silent

Mode

몇몇 CAN controller들은 Silent Mode에 있을 것입니다, 버스에 대한 모

든 메시지들을 받을 수 있지만 어떤 것도 보내지 않습니다(심지어 ACK

bit도 보내지 않습니다)..

이것의 전형적인 용도는 bus analyser 도구들입니다.
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4. CANKing 실행

을 실행하면 아래와 같이 표시됩니다.

그림4-1

위에서 "OK, I know what I'm doing"를 선택합니다. 그러면 아래와 같이 표시됩니다.

그림4-2

위에서 "OK"를 선택합니다. 그러면 아래와 같이 표시됩니다.

그림4-3
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위에서 "OK"를 선택합니다. 그러면 아래와 같이 표시됩니다.

그림4-4
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Baud Rate설정

"CAN Controller" 창에서 "Bus Parameters" 탭을 선택하여 "Bus Speed"를 설정합니다.

그림4-5 그림4-6

위에서 리스트에 없는 전송 속도를 설정할 경우 Choose... 버튼을 선택합니다.

그러면 아래와 같이 표시됩니다.

그림4-7

"Show only close matched"를 클릭하고 빈 칸에 원하는 전송 속도를 입력하면 가능한 설정 값들이 표

시됩니다. 입력되는 값은 bit/s 로 입력하여야 됩니다. 125Kbit/s는 125000 으로 입력해야 됩니다.

전송 속도를 선택하고 OK 버튼을 선택하고 "CAN Controller" 창에서 Apply 버튼을 선택하면 됩니다.
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H/W Filter

CAN Controller 창에서 "H/W Filters" 탭을 선택하면 아래와 같이 표시됩니다.

그림4-8

Transmit 메시지를 아래와 같이 정의 합니다.(다른 CAN card에서)

그림4-9

보기 1: 필터 설정을 아래와 같이 합니다.(Mask: 0, Code: $200)

그림4-10

Mask 가 설정이 되어 있지 않기 때문에 아래와 같이 모든 메시지가 표시될 것입니다.
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그림4-11

보기 2: 필터 설정을 아래와 같이 합니다. (Mask: $FFF, Code: $200)

그림4-12

1111 1111 1111에서 1로 표시된 비트에 대응되는 0010 0000 0000인 메시지만 표시 합니다.

그 결과 아래와 같이 표시될 것입니다. ID: 0x200 메시지만 표시 됩니다.

그림4-13

보기 3: 필터 설정을 아래와 같이 합니다.(Mask: $200, Code: $200)

그림4-14
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xx1x xxxx xxxx에서 x로 표시된 비트에 대응되는 것은 0이나 1중 상관 없고 1로 표시된 비트는 반드시

1로 된 메시지만 표시 합니다. 그 결과 아래와 같이 표시 됩니다. (ID: 200, 201, 210, 2FE, 300)

그림4-15

보기 4: 필터 설정을 아래와 같이 합니다.(Mask: $2FF, Code: $200)

그림4-16

xx1x 1111 1111에서 1로 표시된 비트에 대응되는 메시지는 아래와 같이 표시될 것입니다.

(ID: 200, 300)

그림4-17
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메시지 수신 (Output Window)

메시지가 정상적으로 수신되면 "Output Window"에 표시됩니다.

그림4-18

기본적으로 decimal 값으로 표시됩니다.

"HEX" 값으로 표시하려면 "Select Formatters" 창에서 "Standard Text Format"를 선택하고

Options 버튼을 선택하면 아래와 같이 표시됩니다. 여기서 "Hexadecimal"로 선택하면 됩니다.

그림4-19 그림4-20

그러면 아래와 같이 Hex 값으로 표시되는 것을 볼 수 있습니다.

'291'로 표시된 것은 'decimal' 값이고 '0123'으로 표시된 것은 'Hex' 값입니다.

그림4-21

"Output Window"에서 마우스 오른쪽 버튼을 누르면 아래와 같이 보조 메뉴가 표시됩니다.

그림4-22
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"Fixed Positions" 기능이 설정이 안되어 있으면 "Output Window" 에 표시되는 메시지는 스크롤 됩니다.

그림4-23

이 기능이 설정이 되어 있으면 ID 별로 표시합니다.

그림4-24

보조메뉴에서 "Options..."을 선택하면 아래와 같이 표시됩니다.

그림4-25

수신되는 메시지의 라인수와 폰트를 설정할 수 있습니다.

메시지 저장

Output Window 보조 메뉴에서 "Copy contents to Clipboard"를 선택하면 Output Window에 표시된

내용이 클립보드에 복사됩니다.

클립보드에 복사된 내용을 다른 편집기에 복사하여 활용하면 됩니다.

보조 메뉴에서 "Clear"를 선택하면 Output Window의 내용이 지워집니다.
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메시지 전송

Universal 메시지 전송

메뉴에서 "Messages" → "Universal" → "Universal"를 선택하거나 Ctrl+U를 누릅니다.

그림4-26

그러면 아래와 같이 표시됩니다.

그림4-27

위에 표시된 값들은 decimal 형식입니다. 이것을 16진 형식으로 바꾸려면 메뉴에서 Options →

Global...을 선택합니다. 그러면 아래와 같이 표시될 것입니다.

그림4-28

"Default numeric base"를 Hexdecimal을 선택합니다. 그리고 OK 버튼을 선택합니다.

그러면 아래와 같이 표시될 것입니다.
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그림4-29

여기에 적당한 값들을 입력합니다.

그림4-30

Send 버튼을 선택하면 메시지가 전송됩니다. "Output Window"에서 'Dir' 칸에 'T'라고 표시됩니다.

그림4-31

CAN Identifiers

사용자는 CAN Identifier를 입력할 수 있는 곳에서，아래의 표기법을 사용할 수 있습니다:

Remote Frames: "r"을 ID 번호에 추가합니다. 예를 들면 "0x100r"

Extended (29-bit) Identifiers: "x"을 ID 번호에 추가합니다. 예를 들면 "0x100x"

Hexadecimal input: ID 번호 앞에 "0x" 또는 "$"를 붙입니다.

예를 들면:

- 123 = Standard ID 123 (decimal.)
- 123x = Extended ID 123 (decimal.)
- 123rx = Remote frame, ID 123 (extended, decimal.)
- 0x123x = Extended frame, ID 123 HEX.
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Note

사용자는 16진법(hex)과 10진법(decimal) 표시를 F4 키로 전환할 수 있습니다.

사용자는 Options|Global 메뉴를 사용하여 decimal / hexadecimal 중 우선권을 선택할 수 있습

니다.

Integer 메시지 전송

"Messages" → "Universal" → "1-4 Ints"를 선택합니다.

그림4-32

Data0, Data1, Data2, Data3 각각 2byte씩.

10 → 0x0A, 100 → 0x64 1000 → 0x3E8, 10000 → 0x2710

그림4-33

Long 메시지 전송

"Messages" → "Universal" → "1-2 Longs"를 선택합니다.

그림4-34

Data0, Data1 각각 4byte 10000 → 0x2710, 1000 → 0x3E8

그림4-35
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String 메시지 전송

"Messages" → "Universal" → "String"을 선택하면 아래와 같이 표시됩니다.

그림4-36 → 그림4-37

Send 버튼을 선택하면 Output 창에 아래와 같이 표시될 것입니다.

그림4-38

Traffic Generator 전송

"Messages" → "Universal" → "Traffic Generator"를 선택합니다.

그림4-39

그러면 아래와 같이 표시됩니다. 전송 주기를 설정하는 것입니다.

[Rate Tab]

Interval(ms)

- Constant: 1

Burst size (messages)

- Constant : 1 그림4-40
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전송할 메시지의 수를 정의 합니다. (Fixed to $3E8=1000 message)

그림4-41 그림4-42

전송할 ID의 범위를 설정합니다. (Random $0~$7FF=0~2047)

그림4-43 그림4-44

전송할 데이터를 설정합니다. (Message number in data part, Length:8, Random length)

그림4-45
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'Start automatically on "Start Run"'을 체크하면 CANKing을 실행할 때 Traffic Generator를 자동으로

실행을 합니다.

그림4-46

Start 버튼을 선택하면 설정한 값들로 전송을 합니다.

Error Frame 전송

"Messages" → "Universal" → "Error Frame"

그림4-47

Send Error Flag 버튼을 선택하면 Output 창에 아래와 같이 표시될 것입니다.

그림4-48
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History List

(여러 메시지를 연속적으로 전송할 때 유용합니다.)

"View" → "History list"를 선택합니다.

그림4-49

마우스 오른쪽 버튼을 누를 경우 아래와 같이 보조 메뉴가 표시됩니다.

그림4-50

"Messages" → "Universal" → "Universal Ctrl+U"에서 전송(Send)한 메시지가 표시됩니다.

그림4-51

위에서 "History list" 창에서 "Send All" 을 선택합니다. 그러면 아래와 같이 표시됩니다.
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Timed transmission

그림4-52

Output Window도 표시됩니다.

그림4-53

"History list" 창에 있는 모든 메시지를 "Timed transmission"에 설정된 "Fixed Interval(ms)" 간격으로

전송되는 것을 볼 수 있을 것입니다.

"Fixed Interval(ms)"의 간격을 변경하여 Send 버튼을 누르면 변경된 간격으로 전송됩니다.

여기서는 1000ms로 변경합니다.

그림4-54

위에서 Send 버튼을 선택합니다. 그러면 아래와 같이 표시됩니다.

그림4-55
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그리고 아래와 같이 1000ms 간격으로 메시지가 표시됩니다.

그림4-56

Transmission Mode에서 "Cyclic"을 선택하면 Stop 버튼을 누를 때까지 반복해서 전송합니다.

History list 창에서 Send Selected 버튼을 선택할 경우 선택된 메시지만 전송됩니다.

History list 창에서 Save... 버튼을 선택하면 설정된 내용을 저장합니다.

확장자는 ".hst"로 저장합니다.(문서 편집기로 수정할 수 있습니다).

그림4-57

다시 불러오려면 Load... 버튼을 선택합니다. 그러면 아래와 같이 표시됩니다.
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그림4-58
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5. CAN port가 2개일 때 테스트하는 방법

CANKing 을 실행하면 아래와 같이 표시됩니다.

그림 5-1

위에서 "OK, I know what I'm doing"를 선택합니다. 그러면 아래와 같이 표시됩니다.

그림 5-2

위에서 OK 버튼을 선택합니다. 그러면 아래와 같이 표시됩니다.

그림 5-3
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CAN Kingdom (2 channels)을 선택하고 OK 버튼을 선택합니다.

그림 5-4

그림 5-5
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그림 5-6

Start Run 버튼(녹색)을 누르면 아래 그림에서와 같이 On Bus가 녹색으로 변하여 정상적으로 동작되

고 있음을 표시합니다.

그림 5-7

이제 데이터를 주고 받기 위해 메뉴 중 Messages → Universal → Universal을 선택합니다.
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그림 5-8

CAN Envelope는 CAN ID=100, DLC=8, Line0 ~ Line7에 data를 입력한 뒤 Send 버튼을 누릅니다.

그림 5-9

위 입력된 data에 의해 아래와 같이 CAN1과 CAN2에 송신된 값과 수신된 값들이 표시됩니다.

그림 5-10

위의 과정이 모두 동작된다면 CAN Hardware는 정상적으로 설치된 것입니다.


